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Contacting Infor

If you have questions about Infor products, go to the Infor Xtreme Support portal.

If we update this document after the product release, we will post the new version on this website. We
recommend that you check this website periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.
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1Introduction

Kepware
Kepware software based server is designed for accurate communications, quick setup, and unmatched
interoperability between client applications, industrial devices, and systems. The server provides a
wide range of plug-ins and device drivers and components that match most communication needs.
The plug-in design and single user interface provides consistent access from standards-based
applications and non-standards-based applications with native interfaces.

Factory Track
Infor Factory Track is a comprehensive production automation solution designed specifically for the
manufacturing industry. Manufacturers can manage inventory, track labor, and automate the time and
attendance operations using the Factory Track application. The solution is built on Mongoose, an
innovative, rapid application-development-technology platform that enables you to easily enhance and
extend core applications.
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2System Requirements

The server has minimum system requirements for both software and hardware. These requirements
must be met for the application to operate as designed. This application supports the following Microsoft
Windows operating systems:

• Windows 10 x64 (Pro and Enterprise Edition) 3

• Windows 10 x86 (Pro and Enterprise Edition)
• Windows 8.1 x64 (Windows 8, Pro, and Enterprise Edition) 3

• Windows 8.1 x86 (Windows 8, Pro, and Enterprise Edition)
• Windows 8 x64 (Windows 8, Pro, and Enterprise Edition) 3

• Windows 8 x86 (Windows 8, Pro, and Enterprise Edition)
• Windows 7 x64 (Professional, Ultimate, and Enterprise Edition) 3

• Windows 7 x86 (Professional, Ultimate, and Enterprise Edition)
• Windows Server 2016 x64 3

• Windows Server 2012 x64 R2 3

• Windows Server 2012 x64 3

• Windows Server 2008 x64 R2 3

Note: 

• When installed on a 64-bit operating system, the application runs in a subsystem of Windows called
WOW64 (Windows-on-Windows 64 bit). WOW64 is included on all 64-bit versions of Windows and
is designed to make differences between the operating systems transparent to the user. WOW64
requires the following minimums:

• 1 GHz Processor
• 1 GB installed RAM (defer to the suggestion for the OS)
• 180 MB available disk space
• Ethernet Card

• Verify the latest security updates are installed for the operating system.
• Runs in the 32-bit compatibility mode.
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Components
The server implements client/server architecture. The components include Configuration, Runtime,
Administration, and Event Log.

Configuration
The Configuration is the client-user interface that is used to modify the runtime project. The Configuration
can be launched by multiple users and supports remote Runtime configuration.

CSV Import and Export
The server can import and export tag data in a Comma-Separated Variable (CSV) file to quickly create
tags in an application. The CSV functions are only available when a device or tag group is selected.
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3Accessing the Administration Menu

The Administration Menu is used to view and/or modify user management settings and launch server
applications. To access the Administration Menu, right-click Administration in the System Tray.

 

 

Options in the administration menu:

• Configuration: Launches the OPC server's configuration.
• Start Runtime Service: Starts the server Runtime process and loads the default Runtime project.
• Stop Runtime Service: Disconnects all clients and saves the default Runtime project.
• Reinitialize: Disconnects all clients and resets the Runtime server. It automatically saves and reloads

the default Runtime project without stopping the server Runtime process.
• Reset Event Log: Resets the Event Log. The date, time, and source of the reset are added to the

Event Log in the configuration window.
• Settings: Launches the Settings group
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• OPC UA Configuration: Launches the OPC UA Configuration Manager, if available.
• OPC .NET Configuration: Launches the OPC .NET Configuration Manager.
• Quick Client: Launches the Quick Client.
• License Utility: Launches the server's license utility.
• Help: Launches the server's help documentation.
• Support Information: Launches a dialog that contains basic summary information on both the server

and the drivers currently installed for its use.
• Exit: Closes the Administration and removes it from the System Tray. To view it again, select it from

the Windows Start menu.

12 | Infor Factory Track Kepware Configuration Guide

Accessing the Administration Menu



4Settings

To access the Settings groups, right-click Administration menu on the System Tray.

Settings- Administration
The Administration group is used to configure the Runtime Administration's actions.

 

 

• Automatically start Administration: When enabled, this property enables the Administration to start
automatically. The Administration is a System Tray application that allows quick links to various
server tools including the Settings Console, Configuration, Licensing Utility, User Manager Console
and controls for stopping and starting the Runtime service.

• Product Language Selection: Select the preferred user interface language from the list.

Note: The language settings defaults as the operating system's language.
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Settings Configuration
Use the Configuration group to configure the connection and interaction of the configuration settings
with the Runtime.

 

 

Connection
On connection section of the configuration screen configure the network firewall settings:

• Communicate using port: Specify the TCP/IP port to be used to communicate between the
Configuration and the Runtime. To obtain the default setting, click Default.

• Allow runtime to accept remote connections: If this check is selected, box runtime is allowed to
accept remote connections.

Session Management
Specify the information on the session management section:

• Max Concurrent Configuration Connections: The number of Configuration connections that can be
made to the Runtime at one time. Range is between 1 to 64.

• Idle Session Timeout: The length of time the console connection can be inactive before it is shut
down. The range is 10 to 3600 seconds.

Click Configure to launch the DCOM Configuration Utility and specify the level of security and restrict
access for certain users and/or applications.

Note: If this setting is disabled, the server overrides the DCOM settings set for the application and
does not perform any authentication on the calls received from client applications, risking the client
security.
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Project Backups
 

 

On the Project Backups section

• Backup the Runtime project prior to replacement: If this check box is selected the backup for the
Runtime project is completed before the replacement.
Note: 
• This check box is selected by default.
• The Runtime project is overwritten if either New or Open is selected when connected to the

Runtime.

• Keep the most recent: Specify the number of backup files to be saved. Range is 1 to 1000.

Settings Event Log
The Event Log group is used to define the communication and persistence settings for the Event Log,
OPC Diagnostics Log, and Communications Diagnostics Log.

The settings for each individual log type are independent of the settings for the other log types.
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Connection
Port: Specify the TCP/IP port to be used to communicate between the Log and the Runtime. The valid
range is 49152 to 65535. To restore the default port setting, enter a blank value.

Event Log Settings
Specify these information:

• Persistence Mode: The event log's persistence mode. The options for this mode include Memory,
Single File, and Extended Datastore.

• Max. records: The number of records that the log system retains before the oldest records is deleted.
The valid range is 100 to 100,000 records.
Note:  The log is truncated if this property is set to a value less than the current size of the log.

• Log file path: The path where log file is saved. It is only available when the Persistence Mode is set
to Single File or Extended Datastore.

• Max. single file size: The size that a single datastore file must attain before a new datastore file is
started. The valid range is 100 to 10000 KB. The default setting is 1000 KB.

• Min. days to preserve: The minimum number of days for which a log file can be saved. The valid
range is 1 to 90 days.

Note: The fields are only available when the Persistence Mode is set to Extended Datastore.
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Settings User Manager
The User Manager controls client access to the project's objects, which are the channels, devices,
tags. etc., and the corresponding functions. The User Manager allows permissions to be specified by
user groups. It can restrict the Data Client user access to project tag data based on its permissions
from the Anonymous Clients user group. It can also transfer user information between server installations
through its import / export function.

The User Manager has three built-in groups that each contain a built-in user. The default groups are
Administrators, Server Users, and Anonymous Clients. Users cannot rename or change the description
fields. The default groups and the default users are also not disabled.

Note: The Administrator's settings cannot be changed, but the additional administrative users can be
added.

 

 

The icons can perform these actions:

• New Group: Adds a new user group.
• New User: Adds a new user to the selected user group. This function is disabled for anonymous

clients.
• Edit Properties: Edits the properties of the selected user or user group.
• Disable Selected User/Group: Disables the selected user or user group. This function is only

available to custom users and user groups.
• Restore Selected User/group: Restores the selected user or user group. Restoring a user group

returns the users to the previous state. This icon is only available once a user or user group is
disabled.

Note:  If all disabled users and user groups are restored, the Show disabled option is not displayed.

• Import User Information: Imports user information from an XML file. The selected file must be
exported from the server's Administration utility. This function is only enabled when the built-in
Administrator is logged in.
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• Export User Information: Exports user information to an XML file. The XML file cannot be edited
and re-imported.

Note: Review the User Manager permissions for accuracy after upgrading the server or importing User
Information.

Sub
Shortcuts and additional settings can be accessed through the context menu for user groups and users.

 

 

Right-click User and select Move User To to move the user to a different user group. Both the enabled
and disabled user groups are displayed in the list.

Note: An active user moved to a disabled group becomes disabled as well. A disabled user moved to
an enabled group persists in same status until changed by the administrator.

User Group Properties
Access user group properties from Properties in the User group menu.
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Specify the information for the user group properties:

• Name: The name of the new user group. The maximum number of characters allowed is 31.
• Description: A brief description of the user group. The maximum number of characters allowed is

128.
• Permissions assigned to the selected user group are:

• Project Modification: Enables the controls to default project modifications.
• Server Permissions: Enables the control to access the server functionality.
• I/O Tag Access: Enables the control to access the device-level I/O tag data.
• System Tag Access: Enables the control to access the System tags.
• Internal Tag Access: Enables the control to access the internal tags.
• Browse Project Namespace: Enables the control to browse access to the project namespace in

clients that support browsing.

User Properties
Access the user properties from the user tab or right-click the user tab and select Properties.

 

Infor Factory Track Kepware Configuration Guide | 19

Settings



 

Specify the information in the User properties screen:

Old Password
The active or old password of the user.

Password
A new or updated password to log into the system. It is case-sensitive with a maximum of 127 characters
allowed.

Confirm Password
The new or updated password.
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5Navigating the User Interface

The Configuration provides interacting with the server. While various plug-ins and drivers add buttons,
menus, and icons; the standard interface elements are described below. As you navigate between the
reports within a domain, parameters deliver the context of one report to another. For example, dates,
products, or customers that are selected in one report are passed to the next report.

Note: Do not use the report tree to navigate between reports. If you do, the report parameters cannot
be initialized correctly. This process results in #N/A value errors and empty selection lists. You can
use this table as an example. You can add or delete icons that are used in your navigation.

Each dashboard and report has a toolbar with these options:

Menu Bar

Includes the project-level commands; such as Save, Open, Import, and Export.File

Includes action commands; such as Copy, Paste, and New Channel.Edit

Includes the display commands; such as which elements of the user interface are visible or
hidden and the type of tree organization to display.

View

Includes the configuration commands; such as general options, connection settings, and
Event Log Filters.

Tools

Includes server connectivity commands; such as Connect, Disconnect, and Reinitialize.Run-
time

Includes commands to access the product documentation, by server, driver, or plug-in.Help

Button Bar

Initiates creation of a new project file to replace the active project. The project file
defines the devices connected, their settings, and how they are grouped. New Project

Allows the user to browse for an existing project file to load, replacing the active
project. Open

Project

Implements any recent changes and writes the active project file to disk. Save Project

Writes the active project with changes, such as to a new location or file name. Save As
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Runs the integrated client interface. New Chan-
nel

Runs the integrated client interface. New Device

Runs the integrated client interface. New Tag
Group

Runs the integrated client interface. New Tag

Runs the integrated client interface. Bulk Tag
Creation

Runs the integrated client interface. Duplicate
Tag

Runs the integrated client interface. Properties

Runs the integrated client interface. Undo

Runs the integrated client interface. Cut

Runs the integrated client interface. Copy

Runs the integrated client interface. Paste

Runs the integrated client interface. Delete

Runs the integrated client interface. Quick Client

Project Tree View
Use the Project Tree view to display the current project contents, organization, and settings in a hierarchy
view. The Project Tree View is designed as unified location for all aspect of the project. Expand nodes
to get detailed view of the device, tag group, or tag level list. Features and Plug-ins appear as nodes
in the tree view to facilitate configuration work in one location.
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Major nodes of the tree are:

• Project- The global settings for the active project are updated and saved.
• Connectivity- The channels and devices are organized, right-click actions are available, and properties

can be accessed for display in the Detail pane.
• Aliases- The mappings to system resources, legacy paths, and complex routings can be given

shorter, more user-friendly, or SCADA compatible names and shortcuts.
• Advanced Tags- The operations or analysis can be built into tag processing and saved.
• Alarms & Events- The system monitoring can be defined and managed.
• DataLogger- The data that can be organized and stored in an ODBC-compliant database.
• EFM Exporter- The flow and trend data can be captured and coordinated.
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• IDF for Splunk- The data feeds into data management and data mining can be configured. This is
a separate product Plug-in.

Detail View
This view displays one of several configuration selection options for the active project. Its information
is related to the current Project Tree View.

Note:  Detail View columns is still displayed even after you select a Project Tree View. The screen
closes when a channel or device is selected on the Project Tree View column. The columns displays
the device or tag information.

Event Log
Users can specify the type of events displayed in the Event Log. There are four types of events that
can be recorded: Error Events, Warning Events, Information Events, and Security Events. The description
of the events are:
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Information
Messages that provide status and data requiring no interaction or correction, such as successful
connection or data collection.

Security
Messages that call attention to conditions that are not best practices from a security perspective, such
as running the software as the default user versus a logged-in user with valid credentials.

Warning
Messages that indicate an issue that does not require interaction, but may result in unexpected results,
such as a device not responding.

Error
Messages that alert the user to failures or problems that are researched and corrected for best results.
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6Project Properties

To access the Project Properties groups from the configuration, click Edit/Project Properties.

Project Properties General
Use Identification screen to attach a title and comment to a project for reference. Although the Title
field supports a string of 64 characters, the Description field has no practical limit. Limiting the
Description to the area available within the field, however, improves project load time.

 

 

Identification
Specify the information in these fields:

• Description: An optional phrase to identify the project in reports and monitoring systems.
• Title: An optional word or phrase to identify the project in file names and reports.
• Tags Defined: The number to verify the tag count matches expectations of data collection for this

project (and licensing, if applicable).

Project Properties OPC UA
OPC Unified Architecture (UA) provides a platform independent interoperability standard. It is not a
replacement for OPC Data Access (DA) technologies. For most industrial applications, UA complements
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or enhances an existing DA architecture. The OPC UA group displays the current OPC UA settings in
the server. Click in the specific property's second column to change a setting.

 

 

Server Interface
Specify the information in these fields:

• Enable: The UA server interface is initialized and accepts client connections if set to Yes.
• Log diagnostics: OPC UA stack diagnostics are logged to the Event Log if set to Yes.

Client Sessions
Specify the information in these fields:

• Allow anonymous login: This property specifies whether user name and password are required to
establish a connection. The default setting is No.
Note: If this setting is disabled, users cannot login as the default user in the User Manager. Users
can login as the Administrator provided that a password is set in the User Manager.

• Max. connections: The maximum number of supported connections. The valid range is 1 to 128.
The default setting is 128.

• Minimum session timeout: The UA client's minimum timeout limit for establishing a session. The
default value is 15 seconds.

• Maximum session timeout: The UA client's maximum timeout limit for establishing a session. The
default value is 60 seconds.

• Tag cache timeout: The tag cache timeout. The valid range is 0 to 60 seconds. The default setting
is 5 seconds.
Note:  If UA clients can read/write to unregistered tags at a set interval, users can improve
performance by increasing the timeout.
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Browsing
Specify the information in these fields:

• Return tag properties: The tag property to allow the UA client applications to search for the tag
properties in the address space.

• Return address hints: The tag property to allow the UA client applications to search for the address
formatting hints. Clients receives an error from the server, if the UA client applications can try to
add to the tag database. This setting is disabled by default.

Monitored Items
Max. Data Queue Size: The maximum number of data notifications to be queued for an item. The valid
range is 1 to 100. The data queue is used when the monitored item's update rate is faster than the
subscription's publish rate.

Subscriptions
• Max. retransmit queue size: The maximum number of publishes to be queued per subscription. The

valid range is 1 to 100.
• Max. notifications per publish: The maximum number of notifications per publish. The valid range

is 1 to 65536. This value may affect the connection's performance by limiting the size of the packets
sent from the server to the client.

Note: Default restores the settings to the default/pre-set values.
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7Server Options

To access the Server Options groups from the configuration, click Tool/Options. These settings are
configured on an individual basis.

Options General
Use this screen to specify the general server options such as the process to establish a connection
with the Runtime, to back up saved Configuration project files, and the conditions displaying warning
messages.

 

 

The list of general options are:
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• Immediately attempt to establish a Runtime connection on start: If this check box is selected the
application checks whether the configuration tool connects to the Runtime.

• Keep track of the __ most recently used project files: Specify the number of project files presented
in the MRU (Most Recently Used) list of projects. The valid range is 1 to 16. The default setting is
8.

• Backup saved Configuration project files prior to overwriting: If this check box is enabled the system
automatically makes a backup copy of the last saved Configuration project.

• CSV Import Delimiter: Specify the Comma Separated Variable (CSV) that the server uses to import
and export tag data in a CSV file. Options include comma and semicolon. The default setting is
comma.

• Confirmations: The conditions that force the Configuration to present warning messages to an
operator. The options are:

• Deleting an object: If this check box is selected, all Configuration delete operations displays
warning messages.

• Disconnect: If this check box is selected, all Configuration operations that causes client applications
to be disconnected from the server displays warning messages.

• Prompt to save: If this check box is selected, the Configuration displays a message if the server
is shut down while the project has outstanding changes.

• Confirm Runtime project replacement: If this check box is selected, the project can be opened
and edited offline while the Configuration is connected to the Runtime.

Options Runtime Connection
Use this screen to specify the method to connect to the Runtime.

 

 

Show user login dialog : If this check box is selected, a valid user name and password are required.

Note: User names and permissions are assigned by the administrator.
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8Channel

A channel is a communication medium from the computer to one or more external devices. A channel
can be a serial port, a card installed in the PC or an Ethernet socket. You must define the channel to
be used when communicating with devices, before adding devices to a project. After creating a channel,
only devices supported by the selected driver are added to this channel.

Adding a Channel
Use the channel wizard to add a channel. Specify a valid name to the channel. You can select the
device driver from the list of all the device drivers currently installed in the system. Use the specific
communication parameters. Multiple channels cannot share identical communication parameters.

Note:  Flow Control settings for serial drivers are used when connecting RS422/485 network devices
to the RS232 serial port via a converter. Most RS232 to RS422/485 converters require either no flow
control (None) or that the RTS line is On when the PC is transmitting and set to off when listening
(RTS).

Removing a Channel
Select the desired channel and click Delete to remove a channel from the project. Click Edit/Delete
from the menu.

Channel Creation Wizard
Use the Channel Creation Wizard to configure a channel (defined by the protocol being used). Once
a channel is defined, its properties and settings are used by all devices assigned to that channel. The
specific properties are dependent on the protocol or driver selected.

1 Select Project > Connectivity > New Channel.
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2 Select type of channel to be created from the list of available drivers.
3 Click Next

 

 
4 Specify a name for the channel (used in tag paths, event log messages, and aliasing).
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5 Click Next.
6 Configure the channel properties as per the options and environment.
7 Review the summary for the new channel and click Back to make changes or Finish to close.
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9Device Discovery Procedure

Device Discovery is available for drivers that support searching for the devices on the network. Once
found, devices are added to a channel. The maximum number of devices that can be discovered at
once is 65535.

 

 

1 Select Channel > Device Discovery > Begin discovery.
2 Specify the driver specific discovery properties, such as address range, timeout, discovery scope.
3 Click OK.
4 Discovered devices defaults the fields with the following information Name, ID, Description.
5 Select the device and click Add selected device.
6 Click Close.
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Device
Devices represent the PLCs or other hardware with which the server communicates. The device driver
that the channel is using restricts device selection.

1 Adding a Device
a Click Edit/New Device.
b Specify the device name. This is the browser branch name used in OPC links to access the

device's assigned tags.
c Specify a Network ID. Networked, multi-dropped devices must have a unique identifier so that

the server's data requests are routed correctly.

2 Removing a Device: Select the device and click Delete. You can also click Edit/Delete.
3 Displaying Device Properties: Click Edit/Properties to display a device's properties

Device Creation Wizard
Use the Device Creation Wizard to configure a device for communication and data collection. The
specific properties are dependent on the protocol or selected driver.

To create the device:

1 Select the channel to which device(s) is added.
2 Right-click and select New Device or select Edit > Connectivity > New Device

 

 
3 Specify a name for the device (used in tag paths, event log messages, and aliasing).
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4 Click Next
5 Configure device properties as per the options and environment.
6 Review the summary for the new device and click Back to make changes or Finish to close.

Device Properties General
A device represents a single target on a communications channel. Specify a device ID for each controller,
if the driver supports multiple controllers.

 

 

Identification
Specify the information in these fields:

• Name: A valid name of the device and can be used on multiple channels.
• Description: The information about the device.
• Channel Assignment: The name of the channel to which this device is currently associated.
• Driver: The selected protocol driver for this device. Specify the driver during channel creation.
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• Model: The specific type of device that is associated with this ID. The contents of the menu depends
on the type of communications driver being used.
Note: If the communications driver supports multiple device models, the model selection can only
be changed when there are no client applications connected to the device.

• ID: The device's driver-specific station or node. The ID is a numeric value for many communication
drivers. The ID format can be Decimal, Octal, and Hexadecimal.
Note: If the driver is Ethernet-based or supports an unconventional station or node name, the
device's TCP/IP address may be used as the device ID.

Operating Mode
Specify the information in these fields:

• Data Collection: Select Enable/Disable to control the device's active state.
• Simulated: In the simulation mode, the driver does not attempt to communicate with the physical

device, but the server continues to return valid OPC data. This is a display field.
Note: The server treats all device data as reflective in simulation mode

Device Properties Scan Mode
Use the Scan Mode to specify the subscribed-client requested scan rate for tags that require device
communications. Synchronous and asynchronous device reads and writes are processed immediately.
It is unaffected by the Scan Mode properties.

 

 

Specify these information:

• Scan Mode: The mode of scanning the tags in the device for updates, sent to subscribed clients.
The options are:

• Respect Client-Specified Scan Rate: Select this option to use the scan rate requested by the
client.

• Request Data No Faster than Scan Rate: Select this option to specify the maximum scan rate
to be used. The valid range is 10 to 99999990 milliseconds.

• Request All Data at Scan Rate: Select this option to specify the rate for subscribed clients. The
valid range is 10 to 99999990 milliseconds.

• Do Not Scan, Demand Poll Only: Select this option to get the updates as poll tags that belong
to the device.
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• Initial Updates from Cache: Select Enable/Disable to allow the server to provide the first updates
for newly activated tag references from stored (cached) data.

Note: Cache updates can only be provided when the new item reference shares the same address,
scan rate, data type, client access, and scaling properties.

Device Properties Ethernet Encapsulation
Ethernet Encapsulation mode is designed to provide communication with serial devices connected to
terminal servers on the Ethernet network. A terminal server is essentially a virtual serial port. The
terminal server converts TCP/IP messages on the Ethernet network to serial data. Once the message
is converted to a serial form, users can connect standard devices that support serial communications
to the terminal server.

Ethernet Encapsulation is transparent to the driver. Configure the remaining properties as if connecting
to the device directly on a local serial port.

 

 

Specify these information:

• IP Address: The four-field IP address of the terminal server to which the device is attached. IPs are
specified as YYY.YYY.YYY.YYY.

Note: Devices can have the same IP address if there are multiple devices.

• Port: The Ethernet port to be used when connecting to a remote terminal server.
• Protocol: Select TCP/IP or UDP communications. The selection depends on the nature of the terminal

server being used.

Note: 

• These properties can be changed at any time. Use the User Manager to restrict the access rights
to server features and prevent operators from changing the properties.

• The valid IP Address range is greater than (>) 0.0.0.0 and less than (<) 255.255.255.255.
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Device Properties Tag Generation
The automatic tag database generation features make setting up an application a plug-and-play
operation. Communications drivers can be configured to automatically build a list of tags that correspond
to device-specific data. The driver reads the device's tag information and uses the data to generate
tags within the server, if the target device supports its own local tag database.

 

 

Specify the information in these fields:

• On Device Startup: The option to generate the OPC tags automatically. The options are:

• Do Not Generate on Startup: Prevents the driver from adding any OPC tags to the tag space of
the server.

• Always Generate on Startup: Initiates the driver to evaluate the device for tag information.
• Generate on First Startup: Initiates the driver to evaluate the target device for tag information the

first time the project is run. It also adds any OPC tags to the server tag space.

• On Duplicate Tag: Server controls the OPC tags that were automatically generated and currently
exist in the project. It also prevents automatically generated tags from storing in the server. The
options are:

• Delete on Create: Deletes any tags added to the tag space. This is the default setting.
• Overwrite as Necessary: Guides the server to remove the tags that the communications driver

is replacing with new tags.
• Do not Overwrite: Stops the server from removing any tags, previously generated or already

existing in the server.
• Do not Overwrite, Log Error: Stops the server from removing the tags and displays an error

message when a tag overwrite occurs.

• Parent Group: The group to check the automatically generated tags from mixing with tags specified
manually.

• Allow Automatically Generated Subgroups: Select Enable/Disable to checks if the server
automatically creates subgroups for the automatically generated tags. This is the default setting.

• Create: The creation of automatically generated OPC tags. If the device's configuration has been
modified, Create tags forces the driver to reevaluate the device for possible tag changes.
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Device Properties Time Synchronization
Time Synchronization screen is used to specify the device's time zone and time synchronization
properties. It primarily applies to time stamped data or information from battery-powered devices at
remote locations where the device time may deviate (causing issues with the time-stamped data). To
prevent this problem from occurring, users can specify that the server synchronize the device time.

 

 

Specify the required information:

• Time Zone: The device's time zone. Select one of the first four options in the list to ignore the time
zone.

• Respect Daylight Saving Time: Select Yes or No to follow Daylight Saving Time offset when synching
the device time.

• Time Sync Method: The method of time synchronization. The options are:

• Disabled: No synchronization.
• Absolute: Synchronizes to an absolute time of day.
• Interval: Synchronizes when the device starts and every number of minutes.
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10Tag

A tag represents addresses within the PLC or other hardware device with which the server
communicates. The server gives access to both Dynamic tags and user-defined Static tags. Dynamic
tags are specified directly in the OPC client and device data. User-defined Static tags are initiated in
the server and support tag scaling. You can search for static tags from OPC clients.

Displaying Tag Properties
To display the tag properties for a specific tag, double-click the tag in the Tag Selection pane of the
server configuration.
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Tag Properties General
A tag represents addresses in the PLC or other hardware device with which the server communicates.
The server gives access to both Dynamic tags and user-defined Static tags. Dynamic tags are specified
directly in the OPC client and device data. User-defined Static tags are initiated in the server and
support tag scaling. You can search Static tags from OPC clients.
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Specify these information in the general property groups fields:

Name
The name of the target tag. The tag name can be up to 256 characters in length. The tag name is part
of the OPC browse data. Tag names must be specific in the device branch or tag group branch.

Note: If the application is best suited for using blocks of tags with the same names, use tag groups
to segregate the tags.

Description
The description of the tag.

Address
The target tag's driver address. The address format is based on the driver protocol. The address can
be up to 128 characters.
Click Browse and specify the address. If the driver accepts the address, no error messages are
displayed.

Note: If any errors are displayed, it must be related to the data type selection and not the address
string.

Data Type
The format of the tag's data created in the physical device. The data type setting is important to
determine how a communication driver reads and writes data to a device. The data type of a piece of
data is fixed for many drivers and the driver uses the specific format to read the device's data. In some
cases, the interpretation of device data is done by the user.
For example, a device that uses 16-bit data registers. This indicates that the data is either Short or a
Word. Many register-based devices also support values that span two registers. In these cases the
double register values could be a Long, DWord or Float. When the driver used supports this level of
flexibility, users must specify it how to read data for this tag. By selecting the appropriate data type,
the driver is being told to read one, two, four, eight, or sixteen registers or possibly a Boolean value.
The driver governs the data format being chosen. The data formats used by the communication drivers:

• Default: Uses the driver default data type
• Boolean: Binary value of true or false
• Char: Signed 8-bit integer data
• Byte: Unsigned 8-bit integer data
• Short: Signed 16-bit integer data
• Word: Unsigned 16-bit integer data
• Long: Signed 32-bit integer data
• DWord: Unsigned 32-bit integer data
• LLong: Signed 64-bit integer data
• QWord: Unsigned 64-bit integer data
• Float: 32-bit real value IEEE-754 standard definition
• Double: 64-bit real value IEEE-754 standard definition
• String: Null-terminated Unicode string
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• BCD: Two byte-packed BCD value range is 0-9999
• LBCD: Four byte-packed BCD value range is 0-99999999
• Date:

Client Access
Select the Read Only or Read/Write access for the clients. If Read Only is selected, the data in this
tag cannot be changed. If Read / Write is selected, the tag's data can be changed as required. OPC
client applications can filter tags based on attributes. Changing the access method of this tag may
change the display of the tag in the OPC client screen.

Scan Rate
The update interval for the tag when used with a non-OPC client. OPC clients can control the rate at
which data is scanned by using the update rate that is part of all the OPC groups. The server is used
to specify an update rate on a tag on per tag basis for non-OPC clients. Using the scan rate, users
can tailor the bandwidth requirements of the server to suit the needs of the application. If data that
changes very slowly are required to be read, the scan rate can be forced to read this tag at a slower
rate reducing the demand on the communications channel. The valid range is 10 to 99999990
milliseconds (ms), with a 10 ms increment.

Note: If the server's online full-time operation is available, these properties can be changed at any
time. Changes made to tag properties is displayed immediately; however, OPC clients that are
connected to this tag are not affected until they release and attempt to reacquire it. Use the User
Manager to restrict access rights to server features and prevent operators from changing the properties

Dynamic Tags
Dynamic tag addressing is a second method of defining tags that allows users to define tags only in
the client application. Users only need to create tag items in the client that directly accesses the device
driver's addresses. On client connect, the server creates a virtual tag for that location and starts scanning
for data automatically.

To specify an optional data type, modify one of the strings after the '@' symbol:

• BCD
• Boolean
• Byte
• Chat
• Double
• DWord
• Float
• LBCD
• LLong
• Long
• QWord
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• Short
• String
• Word

If the data type is deleted, the data type based on the device and address is defaulted. The default
data types for all locations are documented in each individual driver's help documentation. If the data
type specified is not valid for the device location, the server rejects the tag and an error is displayed in
the Event Log.

OPC Client Using Dynamic Addressing Example
Scan the 16-bit location "R0001" on the Simulator device. The following Dynamic tag examples assume
that the project created is part of the example.

1 Start the OPC client application and connect to the server
2 Using the Simulator Driver, create a channel and name it "Channel1." Then, make a device and

name it "Device1."
3 Define an item name as "Channel1.Device1.R0001@Short." in the client application.
4 The client project automatically starts receiving data. The default data type for address R0001 in

the Simulator device is Word. To override this, the @Short has been appended to select a data type
of Short.

Note:  When utilizing Dynamic tags in an OPC client application, the use of the @[Data Type]
modifier is not normally required. OPC clients can specify the desired data type as part of the request
when registering a link for a specific data item. The data type specified by the OPC client is used if
it is supported by the communications driver. The @[Data Type] modifier can be useful when ensuring
that a communications driver interprets a piece of data exactly as needed.

Statistic Tags
Statistics tags gives the feedback to client applications regarding the operation of the channel
communications in the server. If the diagnostics are enabled, seven built-in Statistics tags are available.

Tag Group
Tag groups are used to tailor the layout of OPC data into logical groupings that fit the application's
needs. This server allows tag groups to be added to the project. Tag groups allow multiple sets of
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identical tags to be added under the same device. This is convenient when a single device handles
many similar machine segments.

Tag Group Properties
Tag groups allow users to separate OPC data into smaller tag lists, making finding specific tags easier
when browsing the server. The following image used the supplied OPC Quick Client to create Cell1
and Cell2 tag groups and simplify the OPC client browsing.

 

 

To add a new tag group to the project, right-click an existing device or tag group branch and select
New Tag Group from the context menu. You can also click an existing device or tag group branch and
click the New Tag Group icon on the toolbar.

 

 

Tag groups can be added at any level from the device-level down, and multiple tag groups can be
nested together to fit the application's needs. In the OPC Quick Client screen, the fully qualified OPC
item path is "Channel1.Device1.Machine1.Cell1.Tag1". For this OPC item, "Machine1" and "Cell1"
segments are nested tag groups.

Note: These properties can be changed at any time with the server's online full-time operation. Any
changes made to the tag groups take effect immediately. If the name is changed, OPC clients that
have already used the tag group as part of an OPC item request, are not affected until they release
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the item and attempt to reacquire it. New tag groups added to the project immediately allows browsing
from an OPC client. Utilize the User Manager to restrict access rights to server features to prevent
operators from changing the properties.

Tag Management
The server's user-defined tag management features can create a tag database structure to fit each
application's specific nature. You can define multiple tag groups to separate tag data on a
device-by-device basis, and can also easily add large numbers of tags with drag and drop editing. CSV
import and export also allow tag editing in any application. New tags can be added to the application
at any time.

Automatic Tag Database Generation
The OPC server's ability to automatically generate tags for select communication drivers brings OPC
technology one step closer to Plug and Play operation. Tag information can be read directly from a
device, and tags can also be generated from stored tag data. In both the case, users no longer need
to specify OPC tags into the server.

System Tags
System tags provide general error feedback to client applications and allow the operation control when
a device is actively collecting data. System tags also permit a channel or device's standard properties
to be changed from an OPC client application. The number of System tags available at the channel or
device level depends on the nature of the driver being used.

Note: System tags can be grouped according to the purpose as both status and control or property
manipulation.

Property Tags
Property tags are additional tags that can be accessed by any Data Access client by appending the
property name to any fully qualified tag address. When using an OPC client that supports item browsing,
users can search for the tag properties by starting Include tag properties when a client browses the
server in the OPC DA settings.
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Statistic Tags
Statistics tags gives the feedback to client applications regarding the operation of the channel
communications in the server. If the diagnostics are enabled, seven built-in Statistics tags are available.

Modem Tags
Modem tags configure modem properties and monitor modem status. Modem tags are only available
when the Connection Type in Channel Properties is set to Modem.

Communication Serialization Tags
Driver communications occur simultaneously across multiple channels, yielding higher data throughout.
In some applications, it is required that only one channel is allowed to communicate at a time.
Communication Serialization provides this support. Communication Serialization tags are used to
configure and monitor a channel's serialization status. Both the feature and its tags are only available
to specific drivers.
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11Event Log

Users can specify the type of events displayed in the Event Log. There are four types of events that
can be recorded: Error Events, Warning Events, Information Events, and Security Events. The description
of the events are:

Information
Messages that provide status and data requiring no interaction or correction, such as successful
connection or data collection.

Security
Messages that call attention to conditions that are not best practices from a security perspective, such
as running the software as the default user versus a logged-in user with valid credentials.

Warning
Messages that indicate an issue that does not require interaction, but may result in unexpected results,
such as a device not responding.

Error
Messages that alert the user to failures or problems that are researched and corrected for best results.

Infor Factory Track Kepware Configuration Guide | 53

 



54 | Infor Factory Track Kepware Configuration Guide

Event Log



12CSV Import and Export

The server can import and export tag data in a Comma-Separated Variable (CSV) file to quickly create
tags in an application. The CSV functions are only available when a device or tag group is selected.

Creating a template
The process to create and import CSV file is to create a template.

To create a template:

1 Click File|Export CSV and define channels and devices for the project.
2 Define a tag for each device.
3 Export each device or tag group as a CSV file.
4 Use this template in a spreadsheet application that supports CSV files and modify the file as required.

Note:  The resulting CSV file can be saved to disk and re-imported into the server under the same
(or new) device or tag group.

Exporting a Server Tag List
Exporting a server tag list generates a .CSV text file that contains a heading record followed by a record
for each tag defined under the selected device or tag group. The heading record contains these fields:

• Tag Name: The name of the tag as referenced in an OPC client.

Note:  The tag name may contain a group name prefix separated from the tag name with a period.
For example, a tag name of "Group1.Tag1" creates a group named "Group1" that contains "Tag1".

• Address: The device location referenced by the tag.
• Data Type: The data type used for the tag as shown in the server tag's data type drop-down list.
• Respect Data Type: This forces the tag to follow its defined data type, not the OPC client request

(1, 0).
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• Client Access: Read/write access (read only and read/write).
• Scan Rate: The rate in milliseconds at which the tag address is scanned when used with most

non-OPC clients.
• Scaling: Scaling mode (None, Linear, and Square Root).
• Raw Low: Low raw value.
• Raw High: High raw value.
• Scaled Low: Low scaled value.
• Scaled High: High scaled value.
• Scaled Data Type: The data type used for the tag after the scaling is applied.
• Clamp Low: Forces the resulting scaled value to stay within the limit of Scaled Low (1, 0).
• Clamp High: Forces the resulting scaled value to stay within the limit of Scaled High (0, 1)
• Eng. Units: Units string
• Description: The description of the tag.
• Negate Value: Negates the resulting value before being passed to the client when scaling is applied

(1,0)

Note: Each tag record contains the data for each field.

Microsoft Excel is an excellent tool for editing large groups of tags outside the server. Once a template
CSV file is exported, it can be loaded directly into Excel for editing. A CSV file load in Excel would
appear as shown in the image below.
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Importing a CSV Tag List into the Server
The tag list can be imported again in the server after editing. Click File > Import CSV.

Note: This option is only available when a device or tag group is selected.

Using Other Characters as the Delimiter
When a CSV file does not use a comma or semi-colon delimiter, you must :

1 Save the project in XML. Then, perform mass configuration on the XML file instead of using CSV.
2 Perform a search-and-replace on the delimiter in the CSV file and replace the delimiter with a comma

or semicolon. The delimiter being used by the OPC server (either comma or semicolon) must be
set to the replacement character.
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13Adding User - Defined Tags (Example)

The server can get data from a device to the client application in two ways. The most common method
requires to define a set of tags in the server project and uses the name assigned to each tag as the
item of each link between the client and the server. This method makes all user-defined tags available
for browsing within OPC clients.

To add user-defined tags:

1 Select a device from the Connectivity tree node. In this example, 'Device 1' is selected.
2 Select Edit > Connectivity > New Tag to add a new tag. You can also right-click on the selected

device and select New Tag to add a new tag.
3 Edit the properties in Tag Properties - General to match:

• Tag Name: MyFirstTag
• Address: R000
• Description (Optional): My First Simulator Tag
• Data Type: Word
• Client Access: Read/Write
• Scan Rate: 100 milliseconds. This property does not apply to OPC tags.

4 Use Hints to determine the driver's correct settings. Click the question mark in the Tag Properties
to invoke Hints.
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Note:  The Address, Data Type, and Client Access fields depend on the communications driver.
For example, in the Simulator Driver, "R000" is a valid address that supports a data type of Word
and has read / write access.

5 Click Help for additional details. The 'Additional Descriptions' topic is invoked from the driver's help
documention.

6 Click Apply to commit the tag to the server. The tag is now visible in the server.
7 Add a second tag for use in property scaling by clicking New in Tag Properties - General. This

returns the properties to the default setting.
8 Edit the properties in Tag Properties - General to match:

• Tag Name: MySecondTag
• Address: K000
• Description (Optional): My First Scaled Tag
• Data Type: Short
• Client Access: Read/Write

9 Click Apply to commit the new tag to the server. The tag is now visible in the server.

Error Messages
The server generates error messages when the users attempt to add a tag using the same name as
an existing tag. The communications driver generates errors for three possible reasons:

1 If there are any errors specified in the address's format or content (including in the range of a
device-specific data item).

2 When the selected data type is not available for the address.
3 If the selected client access level is not available for the address.

Dynamic Tag Addressing
Dynamic tag addressing defines tags in the client application. Users only need to create a tag item in
the client that directly accesses the device address. On the client connect, the server creates a virtual
tag for that location and start scanning for data automatically.

Note: 

1 The server creates a special Boolean tag for every device in a project that can be used by a client
to determine whether that device is functioning properly. To use this tag, specify the item in the link
as "Error". This tag is zero if the device is communicating properly, or one if the device is not.

2 If the data type is omitted, the driver chooses a default data type based on the device and address
being referenced. The default data types for all locations are documented in the driver's help
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documentation. If the data type specified is not valid for the device location, the server rejects the
tag and an error posts in the Event Log.

3 If a device address is used as the item of a link (such that the address matches the name of a
user-defined tag in the server), the link references the address pointed to by the user-defined tag.
With the server's online full-time operation, users can start using this project in an OPC client now.
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14Testing the Project

The server includes a full-featured OPC Quick Client that supports all of the operations available in
any OPC client application. The Quick Client can access all of the data available in the server application,
and is used to read and write data, perform structured test suites, and test server performance. It also
provides detailed feedback regarding any OPC errors returned by the server.

To test the project:

1 Locate the QPC Quick Client program in the same program group as the server. Then, run the OPC
Quick Client.
 

 
2 Select Edit > New Server Connection to establish a new connection.
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3 Connect to an OPC server locally or remotely via DCOM in Server Properties. By default, this dialog

is pre-configured with the server's Prog ID (which is used by OPC clients to reference a specific
OPC server).
 

 

Note:  Once a connection is made, two things may happen. If the server is running, the OPC Quick
Client makes a connection to the server. If the server is not running, it starts automatically.

4 Select the server connection and select Edit > New Group to add a new group to the connection.
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Note:  Groups act as a container for any tags accessed from the server and provide control over
how tags are updated. All OPC clients use groups to access OPC server data. A number of properties
are attached to a group that allow the OPC client to determine how often the data should be read
from the tags, whether the tags are active or inactive, whether a dead band applies, and so forth.
These properties let the OPC client control how the OPC server operates.

5 Edit the group properties to match the image.
 

 

Note:  The Update Rate, Percent Dead Band, and Active State properties control when and if data
is returned for the group's tags. Descriptions of the properties are:

Name
This name used for reference from the client and can actually be left blank.
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Update Rate
: Icon to check the number of times the data is scanned from the actual device and data is returned
to the OPC client.

Percent Dead Band
This property eliminates or reduces the noise content in the data by only detecting changes when
it exceeds the percentage change that is requested. The percent change is a factor of the data
type of a given tag.

Active State
This property turns all of the tags in this group either on or off.

6 Click OK.

Accessing Tags
OPC server tags must be added to the group before they can be accessed. OPC data access
specifications define a tag browsing interface as one that allows an OPC client to directly access and
display the available tags in an OPC server. By allowing the OPC client application to browse the tag
space of the OPC server, click on the desired tags to automatically add them to a group.

To access tags:

1 Select the group in which the tags need to be placed. Select Edit > New Item to add a new item.
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Note:  The Add Items dialog also provides a tree view of the Browsing section and can be used to
browse into an OPC server to find tags configured at the server. When using the "Example1" project,
users can access the tags previously defined by expanding the branches of the view.

2 Click the tag name and add tags to the OPC group. Item Count displays the number of tags being
added.

3 Click OK.
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Note:  Users can now be able to access data from the server using the two tags that were defined.

Writing Data to the OPC Server
The OPC Quick Client supports two methods for writing data to an OPC server: Synchronous Writes
and Asynchronous Writes. Synchronous writes perform a write operation on the OPC server and wait
for it to complete. Asynchronous writes perform a write on the OPC server but do not wait for the write
to complete. Either method can be chosen when writing data to an OPC item: the different write methods
are more of a factor in OPC client application design.

To write data to the OPC server:

1 Select the item. Right-click on the item and select Synchronous or Asynchronous Writes. For example,
right-click on MyFirstTag and select Asynchronous Write
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.

Note:  Although the Asynchronous 2.0 Write window is displayed, the value continues to update.

2 Click Write Value to enter a new value for the item.
3 Click Apply to write the data. This allows users to continue writing new values without closing the

window.
4 Click OK to write the data and close the window.

Note:  If data is not updated, then the data is not sent to the server.
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15Conclusion

All the basic steps involved in building and testing an OPC project are discussed. Users are encouraged
to continue testing various features of the server and the OPC Quick Client for greater understanding
and comprehension.

You can now begin developing the OPC application. If you are using Visual Basic, refer to the supplied
example projects. These two projects provide both a simple and complex example of how OPC
technology can be used directly in Visual Basic applications.
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